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1 Welcome to the TRAKTOR KONTROL Z2!

 

Dear Native Instruments customer,

Thank you for purchasing the TRAKTOR KONTROL Z2, and for your continued trust in Native
Instruments products.

The TRAKTOR KONTROL Z2 is a both fully integrated TRAKTOR controller and a standalone
digital mixer and audio interface, giving you the full flexibility of DJing with or without your
computer. As a fully-functional DJ mixer, the TRAKTOR KONTROL Z2 lets you plug in turnta-
bles and CD and use the built-in EQs and filter. You can plug in a microphone and auxiliary
audio device (such as an MP3 player). But the real power of the Z2 comes from using both the
internal mixing capabilities along with its function as a fully-integrated TRAKTOR controller,
integrating perfectly with the TRAKTOR SCRATCH PRO software.

The Z2's top features include:

▪ Self-contained DJ mixer, controller, and audio interface

▪ Built-in digital audio processing for standalone mixing — no computer required

▪ Seamless on-the-fly switching between internal TRAKTOR software mixing and Z2 hard-
ware mixing.

▪ High-quality faders, knobs, and buttons

▪ FX knobs for controlling the new TRAKTOR Macro FX and also traditional FX' parameters

▪ Multi-function cue point and Sample trigger controls

▪ Full integration of the new Flux mode in TRAKTOR, allowing you to loop and jump back
and forth to cue points without loosing the timing or phrasing of your tracks

▪ Generous LED feedback via button backlights, meters, light-pipes, and 7-segment dis-
plays

▪ Push-encoders for quick and easy browsing and auto-looping

▪ Internal multi-voltage power supply and USB cable

▪ Bundled with TRAKTOR SCRATCH PRO software and two timecode control records and
two timecode control CDs

Welcome to the TRAKTOR KONTROL Z2!
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▪ Perfectly extendable through the addition of Native Instruments controllers such as the
KONTROL X1 and the KONTROL F1

▪ Built-in USB hub, providing two powered USB ports for connecting other devices such as
additional controllers or hard disks to your computer via the Z2

1.1 Document Conventions
 

This document uses particular formatting to point out special facts and to warn you of poten-
tial issues. The icons introducing the following notes let you see what kind of information can
be expected:

Whenever this exclamation mark icon appears, you should read the corresponding note
carefully and follow the instructions and hints given there if applicable.

This light bulb icon indicates that a note contains useful extra information. This informa-
tion may often help you to solve a task more efficiently, but does not necessarily apply to
the setup or operating systems you are using; however, it's always worth a look.

Furthermore, the following formatting is used:

▪ Text appearing in (drop-down) menus (such as Open…, Save as…) and paths to locations
on your hard drive or other storage devices is printed in italics.

▪ Text referring to elements appearing on the screen (labels of buttons, controls, text next
to checkboxes, etc.) is printed in light blue. Whenever you see this formatting applied,
you will find the same text appearing on your computer screen.

▪ Text referring to elements printed on hardware is formatted orange. Whenever you see this
formatting applied, you will find the same text appearing on the hardware.

▪ Important names and concepts are printed in bold.

► Single instructions are introduced by this play button type arrow.

→ Results of actions are introduced by this smaller arrow.

Welcome to the TRAKTOR KONTROL Z2!
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1.2 Names and Pet Names for Software and Hardware
 

In this manual, we often refer to the TRAKTOR KONTROL Z2 also as the "KONTROL Z2," or
simply the "Z2." Likewise, the TRAKTOR SCRATCH PRO 2 software will most often just be re-
ferred to as "TRAKTOR."

We also refer to the Z2's buttons with both their primary functions capitalized, and their secon-
dary functions capitalized and in parentheses.

1.3 The TRAKTOR KONTROL Z2 Documentation At a Glance
 

1.3.1 The Setup Guide
 

A Setup Guide is available on the TRAKTOR KONTROL Z2 registration page. It will guide you
through the software and hardware installation of your TRAKTOR KONTROL Z2. This should be
your first step before going any further. Find a link to the registration page on the registration
flyer, which is included in your TRAKTOR KONTROL Z2 product box.

1.3.2 The TRAKTOR KONTROL Z2 Manual
 

That's what you are reading right now! After reading the Setup Guide and following its instruc-
tions, you should be ready to go. The next step is to read this document, the TRAKTOR KON-
TROL Z2 Manual. The Manual will teach you how to use your Z2 in combination with the
TRAKTOR software and in a classical DJing setup. It provides a number of step-by-step tutori-
als and workflows, which will help you mastering the Z2 (↑3, Using the Z2 as a Stand-alone DJ
Mixer (Direct Mode) and ↑4, Using the Z2 with TRAKTOR (TRAKTOR Mode)), and a general
hardware reference (↑5, TRAKTOR KONTROL Z2 Hardware Reference) explaining each and ev-
ery element on the device.

1.3.3 The TRAKTOR Manual
 

For in-depth information on all features provided by the TRAKTOR software, please refer to the
TRAKTOR Manual. You can access the TRAKTOR Manual via the Open Manual… entry from
the Help menu in the TRAKTOR software.

Welcome to the TRAKTOR KONTROL Z2!
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1.3.4 The Controller Editor Manual
 

Aside from using your TRAKTOR KONTROL Z2 hardware controller together with the TRAKTOR
software, you can also use it as a versatile MIDI controller to pilot any other MIDI-capable ap-
plication or device. This is made possible by the Controller Editor software, a little application
that allows you to precisely define all MIDI assignments on your Z2 when operated in MIDI
mode. The Controller Editor should have been installed during the installation procedure. For
more information on the Controller Editor and MIDI mapping, please refer to the Controller Edi-
tor Manual; you can access the manual via the Open Manual… entry from the Help menu in
the Controller Editor software.

Welcome to the TRAKTOR KONTROL Z2!
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2 System and Power Requirements

 

2.1 Power Requirements
 

The TRAKTOR KONTROL Z2 requires 115-230VAC (50-60Hz). Because the Z2's power supply
is internal, the standard power cord is all you need to connect.

2.2 Software System Requirements
 

For the minimum system requirements your computer needs to meet, see the TRAKTOR speci-
fications section of the Native Instruments website:

http://www.native-instruments.com/#/en/products/dj/traktor-pro-2/specifications/?page=2050.

To check the compatibility with several operating systems, please have a look at: http://
www.native-instruments.com/compatibility.

System and Power Requirements
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3 Using the Z2 as a Stand-alone DJ Mixer (Direct Mode)

 

Although the Z2 is designed to be a fully integrated mixer, controller, and audio interface for
the TRAKTOR software, you can also use it as a fully-fledged two-channel stand-alone mixer,
without any computer connections. This gives you a great deal of flexibility, allowing you to
play in situations where it might not be possible (or desirable) to use a computer. In the follow-
ing section, we will describe some typical ways to use the Z2 without a computer connection.

In other words, right out of the box — with no software installation necessary — the Z2 is a
solid, high-performing DJ mixer.

3.1 Connectivity
 

For a complete description of inputs and outputs, please read the Hardware Reference chapter
(↑5, TRAKTOR KONTROL Z2 Hardware Reference). The following is a compact list of the Z2's
audio, digital, and power connections.

Audio Inputs

The Z2 has a complete set of standard audio inputs, giving you a great deal of flexibility:

▪ RCA phono inputs, one stereo pair per channel

▪ RCA line-level inputs (for connecting a CD player, for example), one stereo pair per chan-
nel

▪ Auxiliary input (from another audio device, such as an MP3 player)

▪ Microphone input

▪ Two ground screws for turntable grounding

Audio Outputs

▪ Two stereo headphone output jacks: one 1/4-inch jack and one 1/8-inch jack (on front
panel)

▪ A stereo pair of Quarter-inch jacks (balanced) for booth outputs

Using the Z2 as a Stand-alone DJ Mixer (Direct Mode)
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▪ A stereo pair of XLR jacks for main/master outputs

▪ A stereo pair of RCA jacks for main/master outputs

USB and Power

▪ USB Type B port for connecting the Z2 with your computer

▪ Two USB Type A ports (powered USB Hub) for connecting other USB devices to the Z2

▪ AC mains connection (115-230V 50-60Hz)

3.2 Connecting The Z2
 

Connecting the Z2 as a standalone mixer is simple and straightforward (for a more detailed de-
scription, please read the separate Setup Guide as instructed in ↑1.3.1, The Setup Guide):

1. Plug the power cord (included) into the rear panel of the Z2 and connect it to a stable AC
power source (115-230V 50-60Hz).

2. Switch the Z2 on (power switch on rear panel).
3. Connect turntables, CD players, or other stereo audio sources to the INPUT connections

(channels A and B) on the rear panel, turntables connect to the PHONO sockets, CD play-
ers connect to the LINE sockets.

4. The PH-LN switch at the very top of each channel on the top panel must be at the appro-
priate position in order for you to hear sound from that channel. If you have hooked up a
turntable to the channel, be sure that this is switched to PH ("phono") and if you have
connected CD players or other line-level inputs, the position should be LN ("line").

5. Turn the MASTER output knob all the way down (to the left) to avoid unexpectedly loud
levels.

6. Make sure that the TRAKTOR buttons at the top of each channel are off (not illuminated).
If your Z2 is not connected to a computer, both buttons will be off anyway.

7. Connect the MAIN OUT outputs to a mixer or a pair of active speakers.
8. Plug your headphones into the front panel.
9. Get some sound coming from your turntables or CD players.
10. Slowly turn up the MASTER knob until the volume is at the desired level.
If you still can't hear anything, make sure that:

Using the Z2 as a Stand-alone DJ Mixer (Direct Mode)
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▪ The GAIN knobs (at the top of channels A and B) are turned up

▪ The channel faders are up

▪ The FILTER and EQ band knobs (HI, MID, LOW) are in their center position.

For a description of pre-listening tracks, refer to ↑4.1.7, Pre-listening.

3.3 Adding a Microphone Or Other Audio Source
 

You can also plug a microphone and an additional audio source (line level) into the back of
your Z2. Note that the monophonic microphone signal will be summed to both stereo channels
of the main (and booth) outputs. The auxiliary stereo audio source (an MP3 player or CD player
output, for example) will also be summed directly into the output bus. In other words, the Z2's
crossfader and channel faders will have no effect on these inputs.

To connect a microphone:

1. Make sure the VOLUME knob in the AUX / MIC part of the upper-left corner of the top
panel of the Z2 is turned down.

2. Plug your mic into the MIC input plug of the AUX / MIC area on the rear panel of the Z2.
3. Press the mic button next to the AUX / MIC VOLUME knob of the upper-left corner of the

top panel.
4. Slowly turn up the VOLUME knob until you reach the desired microphone volume level.

(Be careful with feedback!).
Plugging in a line-level audio signal is just as easy:

1. Make sure the AUX / MIC VOLUME knob is turned down.
2. Plug in your device with a standard RCA-type audio cable to the AUX inputs of the AUX /

MIC input section on the rear panel.
3. Make sure your device is outputting audio.
4. Turn up the VOLUME knob on the upper left of the Z2's top panel until you reach the de-

sired auxiliary audio volume level.

Using the Z2 as a Stand-alone DJ Mixer (Direct Mode)
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3.4 Using the Channel EQs and Filters
 

The Z2 provides you with a high-quality EQ and filter section on each channel. For a consistent
mixing experience, the internal characteristics of the Z2's EQ are exactly the same as TRAK-
TOR's "P900 Kill" type EQ and "Z" type filter (which are TRAKTOR's default EQ and filter mod-
ules). This way, your Z2 Direct mode mixes will sound the same as the ones you do with the
TRAKTOR software.

The FILTER knob gives you a classic one-knob experience: turn to the left for a high-cut/low-
pass and turn to the right for a low-cut/high-pass filtering. In the center position, no filtering is
applied to the sound.

Although you can change TRAKTOR's internal EQ and filter characteristics, it is not possi-
ble to change the hard-wired EQs and filters in the Z2.

Knob Snap

Sometimes you might want to drop a filter or EQ in or out, without the smooth, classic "knob-
turning" effect. Using the SHIFT button, you can easily create a drop-in and drop-out effect:

1. While a track is playing, press and hold SHIFT while turning the FILTER knob nearly all
the way to the left. The sound should remain unaffected.

2. Release the SHIFT button — you now hear the filter effect, according to the current posi-
tion of the knob

3. Press and hold SHIFT again, this time returning the FILTER knob to its center (neutral
position). The sound is still being filtered, as long as you continue to hold the SHIFT but-
ton down.

4. Release the SHIFT button and you hear your track unfiltered again.

This works the same way for the three (LOW, MID, and HI) EQ knobs. In addition, in TRAK-
TOR mode (see ↑4, Using the Z2 with TRAKTOR (TRAKTOR Mode)), the same effect is
possible, even when using TRAKTOR's internal filter and EQ.

Using the Z2 as a Stand-alone DJ Mixer (Direct Mode)
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4 Using the Z2 with TRAKTOR (TRAKTOR Mode)

 

Although the TRAKTOR KONTROL Z2 can be used as a solid stand-alone DJ mixer, it becomes
most powerful when used with the TRAKTOR software, combining the advantages of a stand-
alone mixer and fully-integrated controller in one unit.

4.1 Basics
 

In this section, we will walk you through some typical scenarios to demonstrate some of the
most common use cases when using the Z2 with TRAKTOR. You might want to refer to ↑5,
TRAKTOR KONTROL Z2 Hardware Reference while going through the following workflows. In
↑5, TRAKTOR KONTROL Z2 Hardware Reference, specific functions of each switch, knob, fad-
er, plug, and display are described in more detail.

In addition, you should refer to the TRAKTOR 2 Manual in case you are uncertain about
specific TRAKTOR functionality.

The Z2 is essentially a two-channel mixer. Although you do have some control of TRAK-
TOR's Decks C and D, the Z2's focus is on two-channel mixing. Therefore, some of the con-
trol possibilities are limited to Decks A and B and are not available for Decks C and D, in
order to keep the Z2 relatively compact and easy-to-use.

4.1.1 Connecting the Z2
 

Please refer to the separate Setup Guide (see also ↑1.3.1, The Setup Guide) for detailed in-
structions on installing the TRAKTOR software, registering the product, and connecting the
hardware.

Here's a quick run-down of the hardware setup:

1. Connect the TRAKTOR KONTROL Z2 to AC power and turn the unit on (rear panel
switch).

2. Connect the Z2 to your computer with a USB cable (included with the Z2).
3. Start TRAKTOR for the first time and set up the software for use with the Z2 using the

Setup Wizard (see also Setup Guide, ↑1.3.1, The Setup Guide).

Using the Z2 with TRAKTOR (TRAKTOR Mode)
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4. On the TRAKTOR software, the Headers of Decks A and B will indicate Direct Thru, mean-
ing that by default, the Z2 is in Direct mode and therefore is not yet enabled for internal
(in the TRAKTOR software) mixing. Inside the Decks of the TRAKTOR software you can
see the message: The Mixer Channel is currently in Thru Mode.

5. Press the TRAKTOR buttons at the very top of channels A and B on the Z2; they are the
buttons with the TRAKTOR logo, on either side of the Snap (S), Settings (cogwheel sym-
bol), and Quantize buttons (Q). This will switch mixing on the respective channels (A and
B) to TRAKTOR mode.

→ You are now ready to load some tracks and start mixing!

If you wish to mix audio coming from turntables or CD players connected to the Z2 (PHO-
NO or LINE inputs, respectively), the TRAKTOR button corresponding to the input channel
will need to be off.

You can even combine TRAKTOR mode with Direct mode on the Z2 in a hybrid way: for
example, you can have an analog record going into channel B (so the TRAKTOR button for
channel B should be off) and have a track playing in the TRAKTOR software on Deck A (the
TRAKTOR button for channel A should be on).

4.1.2 Browsing and Loading
 

For information regarding setting up your Track Collection in TRAKTOR, refer to the TRAK-
TOR 2 Manual.

To browse the Library and load a track or Remix Set into a Deck:

1. Press and release the BROWSE encoder on the Z2 to toggle open the Browser view in
TRAKTOR in order to have a clear view of the Browser and the Browser Tree.

2. Rotate the BROWSE encoder to scroll up or down the list of tracks in the current browser
folder.

3. Press the SHIFT button while rotating the Browse encoder to navigate between folders
and subfolders in the Browser Tree.

4. When you have found the track or Remix Set you wish to load, press the LOAD (DUPLI-
CATE) button (A or B) corresponding to the Deck into which you wish to load your track or
Remix Set.

Using the Z2 with TRAKTOR (TRAKTOR Mode)
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→ The track / Remix Set should now be loaded to one of the Decks A or B.

► Press and release the BROWSE encoder again to minimize TRAKTOR's Browser on the
screen.

Note that you cannot load a Remix Set into a Track Deck, nor can you load a track into a
Remix Deck. But you can change Deck Flavors within the TRAKTOR software by pressing
on a Deck's Deck letter and selecting the Deck Flavor of choice. Please refer to the TRAK-
TOR Manual for further instructions on changing the Deck Flavor.

4.1.3 Duplicating Tracks from Deck to Deck
 

You can use the Z2 to duplicate tracks from one Deck to another. This would be the case if you
have a track loaded into one Deck, but would like to have the same Track loaded into the other
Deck (from Deck A to B or from Deck B to A).

► Press and hold SHIFT and then press the LOAD (DUPLICATE) button corresponding to
the Deck you into which you want to copy the track. For example: You have a track in
Deck B, but you'd like to copy the track over into Deck A, then press the LOAD (DUPLI-
CATE) A button.

When you duplicate a track from one Deck to another in this way, all the cue points and
loops (as well as the current playhead position) will be duplicated as well.

4.1.4 Starting and Stopping Decks
 

Usually when using the Z2 with TRAKTOR, you will be controlling TRAKTOR's Decks with
Timecode vinyl/CDs. This is the default use case when setting up TRAKTOR for use with the
Z2; however, there is a way to start/stop TRAKTOR Decks directly from the Z2. To do this:

► Press and hold SHIFT and press the REL / INTL (A or B) button (depending on which
Deck you would like to start or stop) to toggle Deck playback.

Note that when you start/stop a Deck this way, TRAKTOR will automatically switch the Deck to
Internal Playback mode. In this mode, TRAKTOR will ignore any Timecode control. To switch
back to Timecode control, press the relevant REL / INTL (A or B) button so that it lights up
green. See also ↑5.4.17, REL / INTL Buttons A and B and the TRAKTOR manual for informa-
tion on Internal Playback vs. Absolute/Relative mode (both Timecode modes).

Using the Z2 with TRAKTOR (TRAKTOR Mode)
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Because of the special nature of TRAKTOR's Remix Decks, the Deck transport will start
when you trigger a Sample Slot by pressing one of the four Cue/Sample Trigger buttons.
Once the Deck is playing, you can again push one of the Cue/Sample Trigger buttons to
toggle the Mute/Play state of the corresponding Sample Slot. Refer to the TRAKTOR man-
ual for further info on Remix Decks.

4.1.5 Deck Volume Controls and Crossfader
 

As previously mentioned, the Z2 is essentially a two-channel mixer. The two channel faders,
therefore, control the volume of Decks A and B.

You can control the individual levels of Decks C and D with their individual channel volume
knobs (the knobs with the DECK C and DECK D labeled displays below).

The crossfader fades between both pairs of Decks by default. In other words, if the crossfader
is all the way to the left, you will only hear Decks A and C (if their volume fader of A and the
volume knob of C are turned up). If it is all the way to the right, you will hear both B and D (if
their volume controls are turned up).

You can see whether any sound is playing in Decks C and D by looking at the displays be-
neath their volume knobs (labeled DECK C and DECK D). The illumination level of the la-
bels varies according to the signal level in the Deck, even when the Deck's volume knob is
all the way down. However, the illumination does depend on the gain setting of the channel
— if the GAIN knob (on the TRAKTOR software) is turned all the way down, the Deck vol-
ume knob indicators will be dimmed.

On the TRAKTOR software, it is possible to change what channels are affected by the
crossfader by clicking on the crossfader assign letters left and right of the crossfader (refer
to the TRAKTOR manual for further information).

A Word on Tempo Master

Working with TRAKTOR with the Master Clock in Auto mode, TRAKTOR will automatically set
the currently used Deck to function as the Tempo Master, i.e., all other Decks and FX will be
synced to that Deck. This can be undesirable when using a Deck only for, let's say, performing
scratch routines. There is a setting in TRAKTOR's Transport preferences called "Only On-Air
Decks can be Tempo Master." Deactivating this option will prevent this auto-switching behav-
ior. For further information about Tempo Master and syncing behavior, refer to the TRAKTOR
Manual.
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4.1.6 Adjusting Gain
 

The channel GAIN knob is located at the top of the Z2's channel filter and EQ sections. Note
that you can only adjust the gain for channels A and B using the Z2. Turning the GAIN knob
on the hardware simultaneously moves the GAIN knob in the TRAKTOR software, but only if
the knob is in User-Gain level viewing mode. And here's why: the button can be operated in
two viewing modes: Auto-Gain level and User-Gain level.

A Gain knob in Auto-Gain level viewing mode. Pressing the orange button will switch to User-Gain level viewing mode.

Here's what the two modes display:

▪ User-Gain level: This is the default mode. A blue indicator ring around the knob shows
that you are in this viewing mode. By turning the GAIN knob on the Z2, you change the
mixer channel gain, which has a range of -inf to +12dB. This setting is not stored in your
song file.

▪ Auto-Gain level: Clicking the button next to the label activates Auto-Gain level viewing
mode, the label then displays AUTO. When on, the knob shows the Auto-Gain level stored
with your song file during track analyzis (upon importing the track to the Library). Chang-
ing the Auto-Gain level on the software will also write this new Auto-Gain setting to the
song file.
However, turning the GAIN knob on the Z2, you still alter the User-Gain level, not the Au-
to-Gain level.
Auto-Gain can be activated in the preferences via Mixer > Level > Set Autogain When
Loading Track. Refer to the TRAKTOR manual for further information on Auto-Gain.

Loading a not formerly analyzed track into a Deck, Auto-Gain will be automatically disabled
for that Deck. Only after you reload the relevant track, the proper Auto-Gain setting will be
written to the file and Auto-Gain will be enabled.
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4.1.7 Pre-listening
 

The HP VOLUME knob adjusts the volume levels of the headphone output (this affects both
the 1/4-inch and the 1/8-inch jacks on the Z2's front panel in the same way). The CUE MIX
knob determines whether you hear the main mix only, the cue channel only, or both signals on
your headphones.

Pre-listening to a track works the following way:

1. Load Decks A and B each with a track and begin playback (see also ↑4.1.2, Browsing and
Loading).

2. Turn the CUE MIX knob to the center position.
3. Adjust the HP VOLUME knob to a comfortable level.
4. With the channel faders up, move the crossfader back and forth to hear one track, then

the other.
5. Move the crossfader all the way to channel A so that you are only hearing the track on

Deck A.
6. Press the Cue button B below the CUE MIX knob.

→ The button lights up, showing that Deck B is now sent to the Cue channel, which you now
hear in the headphones.

Notice that now, no matter where you move the crossfader, you will still hear Deck B, because
its cue is on.

► Press Cue button B again to toggle it off and press Cue button A.

→ You will now hear the track playing on Deck A, no matter what position the crossfader is
in.

You can also send only the Cue signal (without the mix signal) to the headphones or only the
mix signal (without the cue signal):

1. Press both Cue buttons A and B so that they are both active (illuminated).
2. Turn the CUE MIX knob all the way to the left.
3. Now toggle the two Cue buttons on and off. Notice that when both Cue buttons are off,

there is no signal at all coming through the headphones.
4. Press both Cue buttons so that they are on.
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5. Turn the CUE MIX knob all the way to the right.
6. Move the crossfader from one side to the other.
Notice that now, there is no cue signal being sent to the headphones.

Remember that no matter what mix you are hearing in your headphones, the main mix is
still controlled by the crossfader and channel faders.

4.2 Creating Loops and BeatJumping
 

The LOOP (SIZE) encoders give you easy access to a number of looping and BeatJumping ac-
tions.

For seamless looping and BeatJumping, make sure that Snap (S) and Quantize (Q) are acti-
vated.

To set a loop in the currently playing track:

1. Set the loop size (from 1/32nd of a beat to 32 beats) by turning the encoder. The loop
size will be displayed in the respective channel display.

2. Press the encoder to begin looping at the playhead position.
3. To move the loop forward or back in the track (by increments corresponding to the loop

size), press and hold SHIFT and turn the LOOP (SIZE) encoder.

With TRAKTOR's new Flux mode, you can trigger loops / cue points while preserving the
track's phrasing. See ↑4.4, Flux Mode for further information on Flux mode and how it af-
fects cue points and loops.

BeatJumping (navigating through the tracks quickly and landing right on the beat) works simi-
larly to looping. BeatJumping works whether or not a Deck is playing:

1. When not looping, set the length of the jump in beats by turning the LOOP (SIZE) encod-
er. The move size will be displayed in the respective channel display. You can jump for-
ward or back in increments ranging from a 1/32nd of a beat to 32 beats.

2. Press SHIFT and turn the encoder to the right (for jumping forward) or to the left (for
jumping back).
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4.3 Using the Cue/Sample Trigger Buttons
 

The Cue/Sample Trigger buttons (1 to 4 on each side of the Z2) make it possible for you to set
and delete cue points and loops, trigger Sample Slots (in Remix Decks) and BeatJump through
your tracks.

For a detailed overview of these buttons' functions, refer to ↑5.4.5, Cue/Sample Trigger
Section (1, 2, 3, 4).

4.3.1 Changing Deck Focus For The Cue/Sample Trigger Buttons
 

The default focus of the Cue/Sample Trigger buttons is Deck A on the left side and Deck B on
the right side. But you can change the Deck focus from A to C or from B to D by pressing the
corresponding Deck Focus button.

To change the focus of the Cue/Sample Trigger buttons:

► Press a Deck Focus button (A or C, and B or D) to change the focus of the Cue/Sample
Trigger buttons.

4.3.2 Working with Cue Points
 

When loading a track which has no stored loops or cue points for the first time, the first
cue point will be set to the beginning of the track automatically. This is a quick way to re-
cue a track to the beginning right from the Z2. You can always delete this default cue point
and set the first cue point somewhere else in the track by pressing SHIFT + Cue/Sample
Trigger button 1.

To set a cue point at the current playback position:

1. Set the Deck focus on the Z2 to the Deck containing the track where you want to set your
cue point (see also ↑4.3.1, Changing Deck Focus For The Cue/Sample Trigger Buttons).

2. Push an empty (not illuminated) Cue/Sample Trigger button (1 to 4). Buttons on the left
of the Z2 control Decks A or C (depending on the Deck focus you have set) and the but-
tons on the right control Decks B or D (also depending on the Deck focus). The button
lights up blue to indicate that a cue point is stored there.
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→ Pressing an empty Cue/Sample Trigger button in this way will set a normal cue point in
your track.

If you want to set a fade-in, fade-out, load, or Grid marker:

► Set a normal cue point first and then change it in the Deck's Advanced Panel in the soft-
ware (please refer to the TRAKTOR 2 Manual for further information).

The Cue/Sample Trigger buttons light up in colors which correspond to the kind of marker
that they represent. See also ↑6.2, The Z2 Audio Interface And Control Panel.

To delete a cue point:

1. Set the Deck focus to the Deck containing the track with cue points you wish to delete.
2. Press and hold SHIFT and then press the relevant Cue/Sample Trigger button containing

the cue point you wish to delete. The button light will go out, indicating that it is now
empty.

Activate Snap and Quantize by pressing the S and Q buttons at the top of the Z2 panel to
get a seamless Hotcue jump.

With TRAKTOR's new Flux mode, you can trigger loops / cue points while preserving the
track's phrasing. See ↑4.4, Flux Mode for further information on Flux mode and how it af-
fects cue points and loops.

You can change the behavior of the Cue/Sample Trigger buttons' secondary functions in
TRAKTOR's preferences. See also ↑5.4.5, Cue/Sample Trigger Section (1, 2, 3, 4).

4.3.3 Working with Loops
 

Storing loops with the Z2 is as easy as setting cue points. The only difference is that a loop
must be active in order to store it. To store a loop on one of the Cue/Sample Trigger buttons (1
to 4):

1. Set the Deck focus on the Deck containing the track where you want to store a loop (see
also ↑4.3.1, Changing Deck Focus For The Cue/Sample Trigger Buttons).

2. With the LOOP (SIZE) encoder, set the length of the loop. The loop length is indicated on
the Loop Size display.

3. Press the LOOP (SIZE) encoder to activate the loop.
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4. Press an empty (unlit) Cue/Sample Trigger button.

→ The button lights up green, to indicate that a loop is stored there.

Both the loop start point and the loop length are stored this way. When you trigger a stored
loop, you can change its current length while it is looping, but the actual markers will re-
main unchanged. If you want to change the actual markers (the start point and loop
length), you will have to delete the loop and then reset it with the desired position and
length with the Cue/Sample Trigger buttons. For more details about loops, see the TRAK-
TOR manual.

To delete a loop stored to a Cue/Sample Trigger button:

► Press SHIFT and then the corresponding Cue/Sample Trigger button.

→ The button will now no longer be lit and can be used for another loop or cue point.

With TRAKTOR's new Flux mode, you can trigger loops / cue points while preserving the
track's phrasing. See ↑4.4, Flux Mode for further information on Flux mode and how it af-
fects cue points and loops.

You can change the behavior of the Cue/Sample Trigger buttons' secondary functions in
TRAKTOR's preferences. See also ↑5.4.5, Cue/Sample Trigger Section (1, 2, 3, 4).

4.3.4 Controlling Remix Decks
 

When the Deck Flavor is set to Remix Deck, the Cue/Sample Trigger buttons function as Sam-
ple Slot triggers and show the color of the focused Sample Cell within the Remix Deck.

You can change Deck Flavors within the TRAKTOR software by pressing on a Deck's Deck
letter and selecting your Deck Flavor of choice. Please refer to the TRAKTOR Manual for
further instructions.

When you load a Remix Deck, the top row of samples in the four Sample Slots will be control-
led by the Cue/Sample Trigger buttons. If the Deck is stopped when a Remix Deck is loaded,
hitting any of the four Cue/Sample Trigger buttons will trigger the Sample Slot and start the
Deck. Once the Deck is playing, repeatedly pressing the buttons will toggle the Mute state of
the Sample Slot on and off.

Triggering a Remix Deck and toggling mute/unmute:
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1. Make sure Deck A is stopped.
2. Set the Deck A to the Remix Deck flavor.
3. Load a Remix Set into Deck A.
4. Press one of the four Cue/Sample Trigger (1 to 4) buttons and the Deck will start playing

the sample in the corresponding Sample Slot.
5. Press the other buttons to hear the other samples.
6. Press one of the buttons a second time to toggle the mute state (the Sample Slot play-

head continues to move in the sample, but the sound is muted). The button blinks to in-
dicate that the Sample Slot is muted.

7. Press the blinking button again to unmute.

You can change the behavior of the Cue/Sample Trigger buttons' secondary functions in
TRAKTOR's preferences. See also ↑5.4.5, Cue/Sample Trigger Section (1, 2, 3, 4).

4.4 Flux Mode
 

What is Flux Mode? Flux mode lets you jump to cue points and loops without loosing the
phrasing of your tracks. It is a timeline-based transport technique that lets you interact with
TRAKTOR's transport controls and then immediately jump back to the position of the timeline
where the track would have been if the transport action had not been used in the first place. In
other words, it is as if a second, virtual playhead continues forward in your song while TRAK-
TOR loops or jumps to a cue point. When you release the loop (or cue point) — by releasing
the relevant Cue/Sample Trigger button (1 - 4) — playback resumes at this playhead position.
The longer you loop, the farther ahead the playhead position will move and therefore the far-
ther ahead playback will jump to when you release the Cue/Sample trigger button. The virtual
Flux mode timeline is represented by a green playhead in the waveform view. Additionally, a
Flux Mode indicator will flash in the Deck Header.
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While playing the track from a stored cue point, the virtual timeline is indicated with the extra green playhead, and the Flux
Mode indicator flashes in the Deck Header.

To toggle Flux mode on Deck A:

► Press the Flux button on the left of the Z2; to toggle Flux mode on Deck B, press the Flux
button on the right.

Note that Flux mode is Deck-specific. In other words, you can have Deck A in normal mode
and Deck B in Flux mode at the same time.

For further information about Flux mode, please see the TRAKTOR manual.

4.5 Filter and EQ Knob Snap
 

The Z2's FILTER and EQ knobs are pretty much self-explanatory. However, there is a feature
that is worth checking out which lets you create a classic "jump cut" filter or EQ effect:

1. With a track playing in Deck A, turn the FILTER knob to the right (to cut the low end). As
you turn the knob, you will hear the lower frequencies being gradually cut off.

2. Now press and hold SHIFT while turning the FILTER knob back to the center position. As
you turn the knob, you won't hear any difference.

3. When the knob is back in the center position, release the SHIFT button.
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→ What happened? When you released the SHIFT button, the filter "snapped" (or "jumped")
back to the center (neutral) position, with no smooth transition. You can use this SHIFT +
turn technique on the EQ band knobs (HI, MID, LOW) as well as the FILTER knobs.

4.6 Macro FX
 

The Z2's compact MACRO FX section lets you control any of TRAKTOR's effects from the hard-
ware. In the following section, we are going to focus on using the Macro FX, which are espe-
cially well-suited to the Z2.

Using TRAKTOR's traditional (non-Macro) FX, the FX knob on the Z2 will control an FX
Unit's third parameter in Single mode, and the first effect in the chain in Group mode. Re-
fer to the TRAKTOR Manual for further information FX Units and their modes.

What are Macro FX?

Macro FX are in fact multiple effects controlled by a single knob. They are carefully designed
by leading sound designers and producers and consist of a combination of "stacked" FX. The
amount of each of the component effects varies with the position of the FX knob on the Z2,
allowing you to quickly and easily add sophisticated effects to your performances.

You'll find a complete description of the Z2's FX section in ↑5.4.2, MACRO FX Sections.

Follow the steps below to get an idea of how powerful this feature is:

1. Load a track in Deck A.
2. Press SHIFT + A (REL / INTL) to start the track.
3. Just under Deck A's FILTER knob are the FX assign buttons. Press button 1.
4. Press and hold SHIFT and rotate the FX knob at the same time. On the TRAKTOR soft-

ware, you will see the effects name change as you turn the FX knob. Stop on one of the
Macro FX (prefixed with "M").

5. Activate the effect by pushing the ON button under the FX knob.
6. Turn the D / W (Dry/Wet) knob towards the right until you can clearly hear the effect.
7. Slowly rotate the FX knob — you will hear a smooth transition between the different posi-

tions of the Macro FX preset.
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It is a good idea to try out all the different Macro FX so that you can get familiar with the
wide range of possibilities available. Some of them are more appropriate for certain styles
than others — try them all to get an idea! In addition, you can choose which effects you
want to have available in TRAKTOR's effects list (maybe you only need three or four differ-
ent effects for your set) in TRAKTOR's preferences. See also ↑5.4.2, MACRO FX Sections.

Note that for Decks C and D, the FX buttons must be on in order for the sound coming from
the Deck to be routed into the assigned FX unit. See also ↑5.4.11, FX Assign Buttons (1,
2).

Note that for Decks C and D, the FX buttons must be on in order for the sound coming from
the Deck to be routed into the assigned FX unit. See also ↑5.4.11, FX Assign Buttons (1,
2).

4.7 Using Additional Controllers
 

The Z2's built-in USB hub makes it very easy to connect external USB devices, such as hard
drives (or even thumb drives with your track collections) or additional controllers. Using the Z2
in conjunction with the TRAKTOR KONTROL X1 will give you more flexibility with controlling
TRAKTOR, especially if you use effects quite heavily.

The TRAKTOR KONTROL F1 is particularly well-suited to be used with the Z2. Since the F1
provides access to the deepest aspects of TRAKTOR's Remix Decks, connecting one or two
F1's to the Z2 will give you the ultimate mixing — and RE-mixing — experience.

4.8 Customizing the Z2
 

If you wish to remap the Z2's controls to other functions, you can create your own controller
template using the Native Instruments Controller Editor, which is installed with the TRAKTOR
software. In addition, it is now possible to simply modify the factory map with mapping over-
rides instead of starting from scratch, when you might only want to change one or two knob
assignments. For more information, see the documentation included with the Controller Editor
software.
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5 TRAKTOR KONTROL Z2 Hardware Reference

 

5.1 Introduction
 

This chapter details the use of each element on your TRAKTOR KONTROL Z2. Like any impor-
tant piece of audio hardware, it is a good idea to get familiar with the Z2 in order to make the
most of this highly versatile mixer and controller. Although the Z2 is very intuitive and easy to
use, many of its controls have multiple functions — especially with regards to controlling the
TRAKTOR software.

After a quick introduction to the main areas on your Z2, we will give you a thorough description
of each control, input, and output element on your Z2.

In this chapter, we refer to the Z2 in TRAKTOR mode, unless noted. In other words, we as-
sume that the Z2 is connected to a computer with the TRAKTOR software installed and run-
ning. For specific Direct mode operation, please see the section ↑3, Using the Z2 as a Stand-
alone DJ Mixer (Direct Mode).

Nearly every action you carry out on your Z2 is instantly mirrored in TRAKTOR when you
are using the Z2 with the TRAKTOR software. Although the Z2 is an excellent stand-alone
mixer, the full feature set comes to life when both software and hardware are used togeth-
er. For an in-depth explanation of all features provided by the TRAKTOR software, please
refer to the TRAKTOR Manual.

A Word about TRAKTOR…

If you are not already a proficient TRAKTOR user, you might want to refer to the TRAKTOR
Manual as you read this chapter. If you are completely new to TRAKTOR, it is a good idea to
work through some of the tutorials in the TRAKTOR Manual, or the TRAKTOR Getting Started
guide — they can be an enjoyable way to quickly learn how to use TRAKTOR effectively!

We assume that you have a basic understanding of many TRAKTOR concepts such as Decks,
Deck Flavors and configurations, looping, cue points, and so on. In addition, you should under-
stand how TRAKTOR's mixer and effects (FX) work.
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Of course, you can operate the Z2 without using TRAKTOR's rich feature set. But you will cer-
tainly be rewarded for taking a little time to learn more about the TRAKTOR software so that
you can get the most out of the Z2 as well.

5.2 Rear Panel
 

The Z2's rear panel.

The rear panel is where you'll connect all the inputs and outputs for your setup and this is, in
many ways, the most important thing to "get right."

5.2.1 AC Power
 

The power switch and the jack on the rear panel.

▪ Power Switch: Switches the TRAKTOR KONTROL Z2 on/off.

▪ Power Jack: Plug in a standard IEC C14-type connector power cord (included) here.
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The Z2 can be powered by any stable AC source (50-60 Hertz) between 115 and 230
Volts.

5.2.2 USB Connections
 

The USB connectors on the rear panel.

Connects the Z2 to your computer with the included USB cable. In addition, the Z2 has a
built-in two-port USB hub for any peripheral devices, such as additional controllers or hard
drives, for example.

The USB port (Type B) connection to your computer is specially-designed to withstand par-
ticularly demanding (party!) performance situations. When plugging your USB cable into
the rear panel of the Z2, you'll notice this extra-tight grip to prevent accidental slippage.

For an overview of the Z2's internal USB routing, refer to ↑6.6, Virtual USB I/O Routing.
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5.2.3 OUTPUT Section
 

The OUTPUT section on the rear panel.

The Z2's OUTPUT section offers a number of different output connections which cover just
about any typical setup situation. Both MAIN OUT outputs are controlled by the MASTER knob
on the top panel. The BOOTH outputs are controlled by the BOOTH knob on the top panel.

MAIN OUT

▪ Balanced XLR: The balanced XLR outputs allow you to connect professional-grade cables
which are much more resistant to electrical interferences than unbalanced cables, espe-
cially over longer distances.

▪ Unbalanced RCA: The RCA outputs give you extra flexibility for connecting to another mixer
or recording device.

BOOTH

The quarter-inch balanced BOOTH outputs give you a pair of separate outputs, useful for moni-
toring for example. You can adjust the level of the BOOTH output with the BOOTH knob (see
also ↑5.4.22, OUTPUT Section), located just below the MASTER knob, in the upper right cor-
ner or the Z2's top panel.

Use the BOOTH outputs for stage (or DJ booth) monitor speakers or for sending your sound
to another musician on stage (for live performance effects, for example). Since you can in-
dependently adjust the levels of both the MAIN/MASTER and the BOOTH outputs, you have
a lot of flexibility with these two sets of outputs.
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5.2.4 INPUT Section
 

The INPUT section on the rear panel.

The channel INPUT section is where you'll be connecting your physical Decks (turntables or
CD players) to the Z2.

▪ PHONO Inputs: Connect a turntable (with Timecode or standard vinyl) to the PHONO
channel inputs. For a more detailed description, please read the separate Setup Guide as
instructed in ↑1.3.1, The Setup Guide.

▪ LINE Inputs: The LINE inputs are for connecting CD players (timecode or standard CD)
and other standard audio devices which provide line-level output levels, including most
portable recorder/players (for a more detailed description, please read the separate Setup
Guide as instructed in ↑1.3.1, The Setup Guide).

Note there are two basic modes the Z2 can be operated in: TRAKTOR mode and Direct
mode. In TRAKTOR mode, the Z2's channels will control TRAKTOR's software Decks. In Di-
rect mode the mixer will work stand-alone and the software will be bypassed. To activate
TRAKTOR mode and, hence, enable Timecode control of TRAKTOR Decks, press the
TRAKTOR buttons next to the phono/lines switches on the top panel of the Z2 so that they
are lit. You can also mix these modes and have one channel operating in Direct mode while
the other is running ion TRAKTOR mode. See also ↑3, Using the Z2 as a Stand-alone DJ
Mixer (Direct Mode) and ↑4, Using the Z2 with TRAKTOR (TRAKTOR Mode).
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5.2.5 AUX / MIC Section
 

The AUX / MIC section on the rear panel.

▪ The AUX input is for connecting a standard line-level source such as an MP3 player or CD
player. Like the MIC input, the AUX input is sent straight to the output summing bus after
passing through the tone EQ stage, which is controlled by the TONE knob on the Z2's top
panel (see also ↑5.4.1, AUX / MIC Controls). (For a more detailed description of connect-
ing equipment via aux inputs, please read the separate Setup Guide as instructed in
↑1.3.1, The Setup Guide.)

▪ The MIC input lets you connect a microphone to the Z2. The signal is sent straight to the
Master outputs and is equally distributed between the left and right channels (for a more
detailed description, please read the separate Setup Guide as instructed in ↑1.3.1, The
Setup Guide).

Both MIC and AUX inputs can be used simultaneously — they are simply mixed together and
sent through the tone EQ stage and then through to the outputs. The signal does not pass
through any of TRAKTOR's FX or through the Z2's channel EQs or Filters.

The MIC input can be muted with the on/off switch (see also ↑5.4.1, AUX / MIC Controls) on
the top panel.

5.2.6 GND (Ground) Screws
 

The ground screws on the rear panel.
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Use the ground screws to earth the turntables you connect to the Z2 in order to prevent un-
wanted hum and other unwanted sounds resulting from ungrounded circuits.

5.2.7 Kensington Lock Port
 

The Kensington lock on the rear panel.

Obviously, you'll want make sure no one "accidentally" walks off with your Z2!

5.3 Front Panel
 

The Z2's front panel.

The front panel consists uniquely of headphone and crossfader elements.
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5.3.1 PHONES Section
 

The PHONES sockets on the front panel.

The Z2 lets you connect two sets of headphones at the same time. The output specs of the
PHONES jacks are identical, only their size differs.

▪ Large headphone jack: For 1/4-inch stereo headphone plugs.

▪ Small headphone jack: For 1/8-inch stereo headphone plugs.

Adjust the levels for both headphone jacks with the HP VOLUME knob on the Z2's top pan-
el.

5.3.2 XF REVERSE Switch
 

The XF REVERSE switch on the front panel.

You can invert the crossfader. When XF REVERSE is ON, an indicator will illuminate at the
bottom of the level meter display on the top panel, and the crossfader's mixer channel assign-
ments will be swapped.

In TRAKTOR mode this will also work; activating XF REVERSE will then switch the software's
crossfader assignments.
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5.3.3 XF CURVE Knob
 

The XF CURVE knob on the front panel.

You can change the type of crossfader curve with this knob. Turned all the way left, the curve
gives a smooth blend between the channels. Turned all the way right, it gives you an on/off
"cut" style blend. This works the same way both for the Z2 in Direct mode and for the software
in TRAKTOR mode.

5.4 Top Panel
 

The vast majority of the time you spend with the Z2 will involve using the top panel controls.
The Z2's hybrid technology lets you use it as a stand-alone DJ mixer (Direct mode) and as
TRAKTOR controller (TRAKTOR mode). You can even mix one channel in Direct mode, and at
the same time you are mixing the other channel in TRAKTOR mode. In addition, you can com-
bine traditional vinyl (or CD) mixing with TRAKTOR Timecode mixing.

The following section describes all of the controls and displays on the Z2's top panel — learn-
ing these functions is the key to mastering the Z2!
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5.4.1 AUX / MIC Controls
 

The AUX / MIC control section on the top panel.

The Z2 lets you connect a microphone and use it either to feed a microphone signal right into
your mix (with an MC, for example), or even to use it as a live input into TRAKTOR. All the mic
settings on the Z2 remain unchanged when you switch between Direct and TRAKTOR mode.
See also ↑5.4.8, TRAKTOR Buttons for an explanation of TRAKTOR mode and Direct mode.

In addition to a microphone, you can connect an audio device such as an MP3 player or other
external device that outputs standard line-level audio.

The Mic/Aux inputs are mixed directly into TRAKTOR's (or the Z2's) main outputs, regard-
less of the mixer's crossfader position.

Use the microphone input to make voice or instrument loops on-the-fly using TRAKTOR 's
Loop Recorder. Make sure to set the source to capture at EXT (external) in the TRAKTOR
preferences (for more information on the Loop Recorder, please refer to the TRAKTOR
Manual).

▪ Microphone button: This button activates the mic input. When on, the button lights up
brightly.

Note that the Mic On/Off button does not toggle between the Mic and Aux inputs — it only
adds the microphone signal to the auxiliary signal, if there is one present.
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▪ VOLUME knob: Use this to adjust the combined mic and aux volume level.

▪ TONE knob: This is a simple, but effective "one-knob" tone control. Turn towards the right
to emphasize higher frequencies (and attenuate lower ones) and towards the left to em-
phasize lower frequencies (and to attenuate higher ones).

The TONE knob can be a quick-fix to possible feedback problems resulting from using a
microphone on stage.

5.4.2 MACRO FX Sections
 

The MACRO FX control section on the top panel.

The MACRO FX sections — one on each channel — are designated Macro FX controls for the
Macro FX in the TRAKTOR software (see also ↑4.6, Macro FX for information about Macro FX);
however, you can also control other effects' parameters with the MACRO FX controls, in which
case the FX knob will control the effect's third parameter in Single mode, and the first effect in
the chain in Group mode.

In order for any effect to be audible, the relevant FX Unit needs to be activated for the channel
via its FX Assign button (see ↑5.4.11, FX Assign Buttons (1, 2)).
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▪ D / W knob: Controls the amount of FX signal (Dry/Wet). Turning this knob completely to
the left results in a completely dry (no FX) signal; turning it completely to the right produ-
ces the full amount of effect.

▪ FX knob: This knob controls the effects mix of the Macro FX in TRAKTOR. The effect will
vary according to the particular Macro FX preset you have loaded and the position of this
knob. For Non-MACRO-FX (the ones without an M in front of their name), the FX knob
works the following way: if the TRAKTOR FX mode is set to Single mode, the FX knob on
the Z2 will control the right-most FX parameter knob on the TRAKTOR software. This is
generally the knob which is most performance-oriented. In Group FX mode, the Z2's FX
knob will control the left-most knob FX knob (the "first" effect in the Group) on the TRAK-
TOR software. Press and hold SHIFT while rotating the FX knob to change the effect load-
ed into TRAKTOR.

You cannot change between single and group effect type from the Z2 hardware — you have
to do this in the TRAKTOR software. However, you can change the actual effect by pushing
SHIFT and turning the FX knob at the same time. At the bottom of the list (FX knob turned
towards the right) are all the Macro FX. In other words, if you are in Single FX mode, you
can choose any single effect and Macro FX. If you are in Group FX mode, you can choose
any group effects and Macro FX. Either way, you can access all of TRAKTOR's Macro FX in
this way!

▪ ON (PRE / POST) button: Toggles the selected FX on and off. Press and hold SHIFT + ON
(PRE / POST) to set the effect from Insert mode to Post Fader mode and vice versa. In
Insert mode, the effect is inserted into the signal chain right before the channel filter. In
Post Fader mode, the effect is inserted into the signal chain after the channel's volume
fader so it will still be audible when turning down the volume on a channel.

TRAKTOR's Macro FX give you a very fast and easy way to add complex effects to your mix.
Try out the different Macro FX presets in TRAKTOR to get an idea of the potential for your
tracks!

Preparing Your Effects List

You can limit your FX choice in TRAKTOR Preferences > Effects > FX Pre-Selection to make it
easier to choose between only a handful of your favorite effects. In addition, the order of the
FX on this list depends on the order you add them. This way, if you put three FX in your "FX
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Pre-Selection" list in the preferences, the first one can be selected from the Z2 by turning the
FX knob (while pressing SHIFT) all the way to the left, the second one when the knob is in the
middle, and the third one when the knob turned is all the way to the right.

5.4.3 DECK C and DECK D Knobs
 

The DECK C volume knob on the top panel.

Use these knobs to adjust the volume for Decks C and D.

The Indicator labels under the knobs ("DECK C" and "DECK D") have an integrated light-
intensity function: the light intensity varies according to the amplitudes of the sounds play-
ing through the respective Decks. This way, even if the volume knob (representing the Deck
fader in the TRAKTOR software) is turned all the way down, you can still see if the Deck is
playing.

By default, the outputs of Decks C and D are mixed directly to the main output and bypass
the crossfader. On the TRAKTOR software, it is possible to change what channels are af-
fected by the crossfader by clicking on the crossfader assign letters left and right of the
crossfader (refer to the TRAKTOR manual for further information).

5.4.4 LOOP (SIZE) Encoders
 

Encoders

The left LOOP (SIZE) encoder on the top panel.
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These encoders control a number of looping and moving (BeatJumping) functions in TRAK-
TOR, as described in the following table:

Action Result

Rotate encoder Increases or decreases the loop size

Press encoder Creates a loop of the specified size, starting at the
current playing position.

The Loop Size display flashes when the loop is active.

If a loop is already active, Loop mode will be deacti-
vated.

Hold SHIFT and rotate encoder while looping Moves the position of the active loop by the size
amount.

Hold SHIFT and rotate encoder while NOT looping BeatJump the current track in forward or back (de-
pending on rotation direction) in current loop sized
jumps. For example, turning to the right when the
loop size is set to 4 will BeatJump forward by four
beats.

Hold SHIFT and press encoder while looping Stop looping (Same as pressing encoder without
SHIFT while looping).

Hold SHIFT, press and hold encoder and turn to the left Reset Deck's beatline to the start. This returns the
track to the beginning.

Holding the SHIFT button while pressing and turning the LOOP (SIZE) encoder left is a
quick and easy way to "reset" your track to the very beginning, even if you have no cue
points set there.

Loop Size Displays

One of the 7-segment displays displaying a loop/move size on the Z2.

The displays display the loop (or move) length as a number. The displays blink when the asso-
ciated track is looping. In addition, they display various options when you press the Z2's Set-
tings button (↑5.4.13, Status/Mode Indicators).
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5.4.5 Cue/Sample Trigger Section (1, 2, 3, 4)
 

The Cue/Sample Trigger section allows for controlling cue points in a Track Deck and Sample
Slots in a Remix Deck. The Deck Focus buttons (C,A, and B,D) select the Deck to be controlled
by the Cue/Sample Trigger buttons; the Cue/Sample Trigger buttons (1 to 4) then control the
underlying Deck's cue points / Sample Slots.

In this chapter you will find a description of the Cue/Sample Trigger section and its controls. A
description of their LED color illumination states can be found in ↑6.2, The Z2 Audio Interface
And Control Panel.

In the TRAKTOR preferences, you can also assign alternative secondary functions to the Cue/
Sample Trigger buttons. A description of these options can be found in ↑6.4, Cue/Sample Trig-
ger Buttons: Optional Secondary Functions for Track Decks and ↑6.5, Cue/Sample Trigger But-
tons: Optional Secondary Functions for Remix Decks.

For a tutorial on using the Cue/Sample Trigger section, refer to ↑4.3, Using the Cue/Sample
Trigger Buttons.

Deck Focus Buttons

The Deck Focus buttons C and A above the left Cue/Sample Trigger section on the Z2.

These buttons let you select the Deck focus of the four Cue/Sample Trigger buttons located
just below. On the left side, you can switch between Decks A and C, and on the right side be-
tween B and D. Using SHIFT with these buttons lets you access the secondary controls of the
Cue/Samples Trigger buttons. The flashing Deck Focus button indicates that the buttons are in
secondary mode.

If one of the Focus buttons is lit or flashing, holding SHIFT and pressing the other Focus
button will switch both the Deck focus and will enter secondary mode at the same time.
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You can determine the secondary mode behavior in the Z2 tab in TRAKTOR's preferences.
E.g., by default, the Cue/Sample Trigger buttons on a Track Deck control cue points 5-8 in
secondary mode. A description of the available alternative secondary funtions can be found in
↑6.4, Cue/Sample Trigger Buttons: Optional Secondary Functions for Track Decks and ↑6.5,
Cue/Sample Trigger Buttons: Optional Secondary Functions for Remix Decks.

On a Remix Deck, you can press and hold the Deck's focus button to override the Loop Encod-
er's function with a "Capture Source Select" option. The Remix Decks will capture from the
"above" Deck by default. In other words, Deck C will capture from Deck A and Deck D will cap-
ture from Deck B. The Loop Size display will then indicate the Capture Source.

To change the Capture Source:

► Press and hold the Deck Focus button of a Remix Deck and turning the Loop Size knob of
that channel

Indication on Loop Size display Capture Source

c_A Capture from Deck A

c_b Capture from Deck B

c_C Capture from Deck C

c_d Capture from Deck D

c_L Capture from the Loop Recorder

You can only capture audio from the Loop Recorder or a Track Deck — you cannot capture
from a Live Input (use the Loop Recorder for that) or another Remix Deck. Therefore, the
options that you see on the Loop Size display will depend on how many Track Decks you
have (the Loop Recorder option is always available).

TRAKTOR KONTROL Z2 Hardware Reference

Top Panel

 

TRAKTOR KONTROL Z2 - Manual - 46



Cue/Sample Trigger (1-4) Buttons

The Cue/Sample Trigger buttons 1 to 4 for Decks A and C.

The function of the Cue/Sample Trigger buttons depends on the underlying Deck Flavor:

▪ For Track Decks, the four buttons control HotCue/loops 1-4 in primary mode and HotCue/
Loops 5-8 in secondary mode (by default).

You can change the secondary mode behavior in TRAKTOR's preferences in the TRAKTOR
KONTROL Z2 tab, under "Secondary Cue." Here you can determine the behavior for both
Track Decks and Remix Decks. See also ↑6.4, Cue/Sample Trigger Buttons: Optional Sec-
ondary Functions for Track Decks and ↑6.5, Cue/Sample Trigger Buttons: Optional Secon-
dary Functions for Remix Decks.

▪ For Remix Decks, the four Cue/Sample Trigger buttons correspond to the four Sample Slots
in the Remix Deck and control the Mute/Play state of each of the four Slots. If the Remix
Deck is stopped, pressing one of the four buttons starts the Deck and plays the corre-
sponding Sample Slot. When the Remix Deck is playing, pressing one of the buttons will
toggle the Mute/Play state of the corresponding Sample Slot. The Cue/Sample Trigger but-
tons light up with the same color as the currently playing Sample Cell in the Remix Deck.
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You can change the secondary mode behavior in TRAKTOR's preferences in the TRAKTOR
KONTROL Z2 tab, under "Secondary Cue." Here you can determine the behavior for both
Track Decks and Remix Decks. See also ↑6.4, Cue/Sample Trigger Buttons: Optional Sec-
ondary Functions for Track Decks and ↑6.5, Cue/Sample Trigger Buttons: Optional Secon-
dary Functions for Remix Decks.

An overview of the Cue/Sample Trigger buttons' functions:

ACTION RESULT

Track Deck (Primary Mode)

Press

If no cue or loop is stored in the slot, a cue point will
be set or a loop will be stored (if in a loop).

If there is a cue or loop stored in the slot, pressing
will jump to the saved cue or loop.

Track Deck (Primary Mode)

SHIFT + Press

If no cue or loop is stored in the slot, nothing hap-
pens.

If a cue or loop is stored in the slot, it will be deleted.

Track Deck (Secondary Mode)

Press

The four buttons work the same as they do in primary
mode, but they control HotCue/loops 5-8

Track Deck (Secondary Mode)

SHIFT + Press

The four buttons work the same as they do in primary
mode, but they control HotCue/loops 5-8

Remix Deck (Primary Mode)

Press

If there is no Sample loaded in the slot, a Sample will
be captured from the selected Track Deck with the
length of the Track Deck's loop size.

If there is a Sample playing unmuted, the slot will be
muted

If there is a Sample playing muted, the Sample Slot
will be unmuted

If there is a stopped Sample in the Slot, the Sample
will start playing and be unmuted.
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ACTION RESULT

Remix Deck (Primary Mode)

SHIFT + Press

If no Sample is loaded in the Slot, this will load the
currently selected entry in the browser

If a Sample is loaded into the slot and playing, this
will stop the playing.

If a Sample is loaded into the Sample Slot and stop-
ped, this will unload the Slot.

Remix Deck (Secondary Mode)

Press

Retriggers the selected Sample Slot

Remix Deck (Secondary Mode)

SHIFT + Press

If no Sample is loaded in the Sample Slot, this will
load the currently selected entry in the browser.

If a Sample is loaded into the Sample Slot, this will
stop it.

5.4.6 FLUX Buttons
 

The left FLUX (TAP) button on the top panel.

To toggle back and forth between Flux mode and normal mode, press the FLUX (TAP) button
on either channel. By pressing SHIFT at the same time, the FLUX (TAP) buttons blink at the
current Deck's tempo. See ↑4.4, Flux Mode for further information about Flux mode.

Tap Tempo

To tap the tempo of Deck A or B:

► Press and hold SHIFT and then tap the channel's FLUX (TAP) button at the desired tem-
po.
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5.4.7 Phono/Line Switches (PH / LN)
 

Deck A's phono/line switch to the left of the TRAKTOR mode button.

These switches let you choose the analog input source for the TRAKTOR KONTROL Z2. There
are two main stereo channel inputs on the Z2, and each has separate phono and line inputs.
The switch determines which of the two inputs will be fed into the mixer channel (the Z2's in-
ternal mixer) and fed up to the computer via USB (for Timecode input or for use in a Live In-
put Deck).

5.4.8 TRAKTOR Buttons
 

Channel A's TRAKTOR button to the right of the phono/line switches.

This is a very vital control. The TRAKTOR button activates TRAKTOR mode for the correspond-
ing mixer channel, which means that the audio entering this channel is being sent to TRAK-
TOR, and not handled internally in the Z2 (Direct mode). TRAKTOR mode is the mode for
Timecode control of TRAKTOR Decks.

When the button is off (not illuminated), all audio coming into the channel is processed by the
Z2. The channel then operates in Direct mode. This means that gain, EQ, volume, and pre-
listening are all done independently of TRAKTOR.

You have no control of the TRAKTOR software on a channel in Direct mode, since the ac-
tual audio processing is carried out by the Z2 internally.

You can literally switch between Z2 hardware mixing and TRAKTOR mixing on-the-fly, with-
out any glitches. This gives you a great deal of flexibility.
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Deck Flavor Toggle

The TRAKTOR buttons can also be used to toggle to the Live Input flavor and then back to the
previous Deck flavor. For example, if Deck A is currently a Track Deck and you wish to use it as
a Live Input Deck to capture some audio on-the-fly, hold SHIFT and press a TRAKTOR button;
the Deck flavor will switch to a Live Input Deck. When you are finished and want to use the
Deck as a Track Deck again, just push SHIFT and the TRAKTOR button again to toggle back.

5.4.9 GAIN Knobs
 

A channel's GAIN knob on the top panel.

These knobs control both TRAKTOR's User-Gain level and the Z2's internal direct gain simulta-
neously. Note that these knobs only control the gain of Decks A and B. It is not possible to
control the channel gain of Tracks C and D directly from the Z2. See also ↑5.4.3, DECK C and
DECK D Knobs.
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5.4.10 EQ (HI, MID, LOW) and FILTER Controls
 

A channel's EQ (HI, MID, and LOW) and FILTER knobs on the top panel.

Just below the GAIN knob at the top of each of the Z2's channels, you will see three EQ knobs
(HI, MID, and LOW) and a FILTER knob. The Z2's high-quality filter and EQ section gives you
a fast and easy way to adjust for frequency imbalances, but also gives you quick access to fil-
ter and EQ effects.

You can "drop" a filter (or an EQ band) in or out of the mix by using the SHIFT button. See
also ↑4.5, Filter and EQ Knob Snap.
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The Z2's internal EQ type is exactly like the "P900 KILL" in TRAKTOR software. When used
as a standalone mixer (no connection to the TRAKTOR software), this will always be the EQ
type used. By default, this is also the EQ type in TRAKTOR as well, so when using the Z2
to mix in TRAKTOR, you will notice absolutely no change in the sound of the EQ. However,
in the TRAKTOR preferences you can change the EQ type In the Mixer tab.

HI-EQ Knobs

The HI-EQ knobs control the high equalizer band of the channel both in the TRAKTOR soft-
ware and in the Z2 simultaneously. The center position corresponds to 0dB and provides no
boost or cut to the frequency band.

MID-EQ Knobs

Similarly, the MID-EQ knobs control the mid-range band of the associated channel, both in the
TRAKTOR software and in the Z2 simultaneously. The center position corresponds to 0dB and
provides no boost or cut to the band.

LOW-EQ Knobs

Just like the HI and MID-EQ knobs, the LOW-EQ knobs also control their respective frequency
bands — in this case the low band. The center position of the LOW-EQ knobs also have no
effect on the sound: 0bB with no boost or cut in the low band.

Filter Knobs

The two FILTER knobs give you a one-knob control of a pair of perfectly-matched filters: a low
pass (turning to the left of the center position) and a high pass (turning to the right of the cen-
ter position) filter. Like the EQ knobs, the center position corresponds to 0dB and has no ef-
fect on the sound.

If the Z2's hardware knobs ever appear to be off center with regards to the what the TRAK-
TOR software is showing, you can always recalibrate them easily. To do this, go into TRAK-
TOR's preferences and open the Z2 tab.
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5.4.11 FX Assign Buttons (1, 2)
 

A Deck's FX assign buttons for FX Units 1 and 2.

The FX Assign buttons route the associated Deck (A or B) to either or both of TRAKTOR's FX.

Pressing SHIFT + the FX buttons assigns the lower Decks (C and D) to their respective FX
Units in TRAKTOR.

Although the Z2 has its own great-sounding filters and EQs, the FX are not internal — they
are not available in standalone mode. Therefore, to use TRAKTOR's FX, you'll need to be in
TRAKTOR control mode.

By default, TRAKTOR's FX routing is "post fader," which means that the effect is not affected
by the channel fader postion. For example, if you have a channel assigned to a reverb effect,
bringing the channel fader down will not change the reverb volume. This is very useful for
"fade to delay" or "fade to reverb" situations. You can always change to Insert mode if you pre-
fer to control the effects level with the channel faders. See the TRAKTOR Manual for further
reference on Insert and Post Fader modes.

5.4.12 7-Segment Displays
 

One of the 7-segment displays displaying a loop/move size on the Z2.

The 7-segment displays are used for displaying information about loop/move size, and settings
options. For further information, refer to ↑5.4.4, LOOP (SIZE) Encoders and ↑5.4.13, Status/
Mode Indicators.
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5.4.13 Status/Mode Indicators
 

The status/mode indicators and the S (Snap), Q (Quantize), and Settings buttons below.

The three icons at the very top of the center panel of the Z2 tell you important operating status
information. There are three different LED indicators: alert symbol, USB symbol, and the Time-
code symbol. The following table describes the messages:

INDICATOR MEANING

Alert symbol Low RAM, flashes at a one-second interval

USB symbol No connection to computer: Dim state

Controller action being triggered: Flashing

Connection established: Brightly lit

Timecode symbol Failed Timecode calibration: Blink (one second inter-
val)

Low input level: Fast blink (0.5 second interval)

Ground hum detected: Fast blink (0.5 second inter-
val)

Left or right channel missing: Fast blink (0.5 second
interval)

5.4.14 S (Snap), Q (Quantize), and Settings Buttons
 

The S (Snap), Q (Quantize), and Settings buttons with the status/mode indicators above.
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Just under the status/mode indicators are three small, but important buttons.

▪ S (Snap): Pressing the Snap on/off button toggles TRAKTOR's global Snap feature on or
off. When global Snap is on, the button also lights up blue and is off when Snap is off.

▪ Settings button: The Settings button toggles the Settings mode on and off. This only
works when TRAKTOR is connected (i.e., not when you use the Z2 in Direct mode; see
also ↑5.4.8, TRAKTOR Buttons). The Settings button blinks on and off when the Settings
mode is active. There are three different sets of parameters which you can control in Set-
tings Mode: Timecode Parameters, LED Meter Parameters, and Layout Parameters. You can
switch between the three different kinds of parameters by turning the left LOOP (SIZE)
encoder. See the sections below for a description of the parameters.

▪ Q (Quantize): The Quantize button activates/deactivates the global Quantize in TRAKTOR.
When the button is on (blue), global Quantize is engaged and when the button not lit,
global Quantize is also off.

Timecode Parameters

See the Settings button's +description above to see how to enter this Settings mode. The
Timecode Parameter is shown by "tC" on the left LED display. The right display gives you a
number of options:

▪ Calibrate Deck A: This is represented by "C_A" on the right LED display. You can trigger
the calibaration for Deck A by pressing the right LOOP (SIZE) encoder.

▪ Calibrate Deck B: The right display shows "C_b". Press the encoder to trigger calibration for
Deck B.

▪ Deck Swap: The right display shows the current configuration which is "A_b" by default. To
swap Decks A and B, just press the right LOOP (SIZE) encoder and it will display "b_A".
Press again to toggle back to the previous state.

▪ Reset: The right display shows "rES". Press the right LOOP (SIZE) encoder to reset all in-
put and output routing configurations to their default values.
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LED Meter Parameters

See the Settings button's description above to see how to enter this Settings mode. The LED
Parameter adjustment affects the Levels Meters on the Z2. Turning the left LOOP (SIZE) en-
coder another notch calls up the LED Meter Parameters, which is shown by "LEd" in the left
LED display. There are no sub-parameters, so the right LED display shows the current meter
mode. The options are:

▪ Main Out: This is shown with "OUt" on the right LED display. When this option is activated,
the Meters show the sum Main Out level

▪ C and D: The right LED display shows "C_d", meaning that the left meter shows the mono-
summed level of Deck C and the right meter shows the mono-summed level of Deck D.

Layout Parameters

See the Settings button's description above to see how to enter this Settings mode. The third
parameter category is "Layouts" and is represented by "LAY" in the left display. Use the right
LED side to select different TRAKTOR layouts on your computer screen using the LOOP (SIZE)
encoder. The right display shows the number corresponding to the selected layout. You go up
or down the list of layouts by turning the right LOOP (SIZE) encoder to the left (counterclock-
wise) or to the right (clockwise).

You can customize layouts in the Layout Manager tab of the TRAKTOR Preferences.

5.4.15 BROWSE and LOAD Controls
 

You can browse and load your tracks directly from the Z2 mixer with the BROWSE encoder and
the LOAD (DUPLICATE) buttons.
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BROWSE Encoder

The BROWSE encoder with the LOAD (DUPLICATE) buttons below.

Use the BROWSE encoder to select the next song to be loaded into a Deck from TRAKTOR's
Library. Used with the SHIFT button, the BROWSE encoder has a number of functions which
are summarized in the following table:

ACTION RESULT

Rotate encoder Move the selection highlight up (counterclockwise)
and down (clockwise) in the File List

Press and rotate encoder Scroll in the File List by increments of ten

Press and release encoder (without turning) Enter/exit Browse mode (full screen browsing)

Hold SHIFT and rotate encoder Move the selection highlight up (counterclockwise) or
down (clockwise) through the Browser Tree

Hold SHIFT and press encoder Expand or collapse the currently selected Browser
Tree branch

Hold SHIFT and press and rotate encoder Scroll the Browser Tree in increments of ten
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LOAD (DUPLICATE) Buttons

The LOAD (DUPLICATE) buttons with the BROWSE encoder above.

Pushing one of the LOAD (DUPLICATE) buttons (A or B) loads the selected track into the cor-
responding Deck.

Like the BROWSE encoder, the LOAD (DUPLICATE) buttons have a secondary function — du-
plicating a Deck's content. When you press and hold SHIFT and then push one of the LOAD
(DUPLICATE) buttons, you will duplicate the content from the opposite Deck. For example, if
you press SHIFT and the "B" LOAD (DUPLICATE) button, the track and its transport data
(whether or not it is playing, looped, etc.) from Deck A will be duplicated to Deck B.

5.4.16 Headphone and Cue Control Area
 

The headphone control area on the Z2.
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▪ HP VOLUME (headphone volume) knob: Use this knob to adjust the headphone volume
level on your Z2. This knob controls both the hard-wired headphone volume in the Z2 and
the headphone volume knob on the TRAKTOR software. Headphone volume output is off
when the knob is turned all the way to the left and it is at its fullest when the knob is
turned all the way to the right.

▪ CUE MIX (headphone cue mix) knob: This knob directly adjusts the cue mix. When it is
turned all the way to the left, the headphones will output the cue channel only. When the
knob is all they way to the right, it will output the master signal only. When the knob is at
the center position, the headphones will receive a blend of both output busses. Fading
between the two positions will mix between the two signals.

▪ A and B (headphone channel cue) buttons: The two headphone cue buttons are located
just below the CUE MIX knob and control the pre-listen monitor function. When on, the
channel's audio is sent to the headphone bus so that you can monitor it. Pressing either
of these buttons toggles the pre-listen monitor function on and off on Decks A or B. If you
hold SHIFT while pressing either button, you can toggle this function on and off on Decks
C or D.

5.4.17 REL / INTL Buttons A and B
 

The Play mode buttons on the Z2.

If you are using Timecode records or CDs to control TRAKTOR, pressing either of the REL /
INTL buttons toggles the mode of the respective Deck between being controlled by the Time-
code medium (Scratch Control) and Internal Playback, where the timecode medium is being
ignored by TRAKTOR.

You can also start or stop Deck A or B by pressing SHIFT + REL / INTL; this will also automati-
cally enable Internal Playback mode.

When you press SHIFT + REL / INTL, the associated Deck will be forced into Internal Play-
back mode (regardless of the previous state) and the Deck will start playing if previously
stopped and will stop playing if previously playing.
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The REL / INTL buttons indicate their state with colored LEDs:

▪ Green indicates Internal Playback mode, where the TRAKTOR software is controlling Deck
playback.

▪ Orange indicates Relative (or Absolute) modes, where an external Timecode record or CD
is controlling the Deck playback.

5.4.18 SYNC Buttons A and B
 

The Sync buttons A and B.

The SYNC buttons toggle the Deck's Sync function on or off. When Sync is on, the button will
light up (Orange LED). If the Deck is in a half-sync state (e.g., with a half-lit SYNC button on
the TRAKTOR software), the button will be dimly lit.

If you hold SHIFT+SYNC A or B for more than one second, the beat grid from the opposite
Track Deck will be applied to the associated Deck. For example if you press and hold the
SHIFT button and the SYNC "B" button, the beat grid from the track in Deck A will be copied
onto the track in Deck B.

Pressing the SYNC button (without SHIFT) for more than one second will reset the associated
Deck's tempo (i.e., it will return to it's original tempo with 0% pitch adjust).

5.4.19 SHIFT Button
 

The SHIFT button on the Z2's top panel.

The SHIFT button acts as a modifier (just like pressing [Shift] on a computer keyboard) and
enables controls to perform secondary functions. Secondary functions are listed along with the
primary function descriptions in this TRAKTOR KONTROL Z2 User Manual.
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5.4.20 Level Meters
 

The level meters in between the volume faders on the top panel.

The Z2's level meters are located right above the crossfader. In their factory default setting,
they show the left/right master output ("MST" on the Z2) and the mono-summed levels of
Decks A and B.

By changing the mixer settings (see ↑5.4.13, Status/Mode Indicators) you can set the display
to indicate the levels of Decks C and D instead of the master output.

Crossfader Reverse Indicator

The XF REVERSE indicator lights up at the bottom of the levels display when the XF REVERSE
switch is activated (on the front panel of the Z2, see also ↑5.3, Front Panel).

Crossfader Reverse only affects a channel in Direct mode. Refer to the TRAKTOR Manual
for further information on Direct mode.
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5.4.21 Volume Faders And Crossfader
 

The volume faders and the crossfader.

Channel Volume

The channel volume faders control the volume of the associated channel.

The channel volume faders control Decks A and B — to adjust the volume on Decks C and
D, use the Deck (C and D) volume knobs. See ↑5.4.3, DECK C and DECK D Knobs.

Crossfader

The crossfader lets you mix between two channels. Note that if the channel faders are turned
up in all four Decks, you will be able to crossfade between any two sets of Decks. See the
TRAKTOR manual for more details.

Crossfader reverse: On the front panel of the Z2, the XF REVERSE switch lets you reverse the
crossfader direction. When on, the Level Meter will also display XF REVERSE.
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Crossfader reverse only works with internal Z2 mixing, not when you are mixing in TRAK-
TOR mode.

5.4.22 OUTPUT Section
 

The OUTPUT section on the Z2.

▪ MASTER volume knob: The MASTER volume knob adjusts the volume of the Z2's MAIN/
MASTER outputs located on the Z2's rear panel.

▪ BOOTH volume knob: The BOOTH volume knob adjusts the volume of the BOOTH outputs
located on the Z2's rear panel.

TRAKTOR KONTROL Z2 Hardware Reference

Top Panel

 

TRAKTOR KONTROL Z2 - Manual - 64



6 Appendix

 

6.1 The Z2's Preferences In TRAKTOR
 

The TRAKTOR preferences have a section dedicated to your TRAKTOR KONTROL Z2 when it is
connected. Open the TRAKTOR preferences either by clicking the cogwheel symbol in the soft-
ware's upper right corner, or via File > Preferences... > Traktor Kontrol Z2.
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The TRAKTOR KONTROL Z2 preferences section in the TRAKTOR preferences.

There are five areas with Z2 specific settings here: Mic/Aux Input, Secondary Cue, Restore De-
fault, Calibration, and LEDs. See the following sections for further description:
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6.1.1 Mic/Aux Input
 

The Mic/Aux Input area in the Z2 preferences.

Activate the Route mic/aux input through TRAKTOR option to route signals connected to this
section on the back of the Z2 through TRAKTOR instead of sending it directly to the Z2's out-
puts.

6.1.2 Secondary Cue
 

The Secondary Cue area in the Z2 preferences.

Assign alternative secondary controls to the Cue/Sample Trigger buttons here. See ↑6.4, Cue/
Sample Trigger Buttons: Optional Secondary Functions for Track Decks and ↑6.5, Cue/Sample
Trigger Buttons: Optional Secondary Functions for Remix Decks for further description.

6.1.3 Restore Default
 

The Restore Default area in the Z2 preferences.

Clicking this button restores all Z2 settings to the factory settings.
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6.1.4 Calibration
 

The Calibration area in the Z2 preferences.

Use these controls if your Z2's controls appear to have decalibrated. Pressing one of the but-
tons will recalibrate the relevant mixer controls.

6.1.5 LEDs
 

The LEDs area in the Z2 preferences.

Set the Z2's LEDs On State Brightness and Dim State Percentage with these sliders.

6.2 The Z2 Audio Interface And Control Panel
 

Your TRAKTOR KONTROL Z2 is equipped with a high-end audio interface. You can adjust the
audio interface settings to your needs and computer performance.

Depending on whether you work on Windows or Mac OS X, you can adjust these settings in dif-
ferent ways.
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6.2.1 Settings on Mac OS X
 

On Mac OS X, you can adjust the settings for the Z2 audio interface from within each music
application. In TRAKTOR:

► Open Preferences > Audio Setup to access the settings for the Z2 audio interface.

There, you can adjust the audio interface settings of the TRAKTOR KONTROL Z2. You have
two settings:

▪ Sample Rate: The Sample Rate is fixed to 48000 Hz for the TRAKTOR KONTROL Z2's
audio interface.

The sample rate defines how many samples are played/recorded per one second of sound.
A higher sample rate results in higher audio quality; however, 44100 Hz (as used for re-
cording audio CDs) is a common setting and absolutely sufficient for most tasks. If your fi-
nal destination is CD you should use this setting or a multiple of it (88200 Hz). For a bet-
ter understanding: 48000 Hz is used by DAT recorders, and for DVD (films) recording.
96000 Hz is typical for DVD, HD DVD, and Blue-ray Disc audio recording. You should be
aware that a higher sample rate also causes higher CPU load.

▪ Latency : Lower the latency value for a quicker response of your computer to TRAKTOR
controller and software actions.

When converting audio information to digital and vice versa, the audio driver needs to store
the data in buffer packages (audio buffers) which are then sent to and processed by the
CPU. The higher the buffer size, the longer it takes for a signal to finally arrive at the out-
put as audio. You might experience this as late response in between hitting a key on a con-
troller which controls music software on your computer, and hearing sound at the output.
This delay is called latency. You should start off with a higher latency value, and gradually
decrease it until you find the perfect balance between playability and audio quality for your
system. If you experience crackling at the audio output, the latency value is very likely to
be too low for your computer’s CPU to cope with, as lower latency values cause a higher
load on the CPU.
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6.2.2 Settings on Windows: The Control Panel
 

On Windows, the settings for the TRAKTOR KONTROL Z2 audio interface are accessed via a
tool called Control Panel. The Control Panel was installed together with the drivers for your Z2
during the TRAKTOR installation procedure. This section describes the Control Panel user in-
terface.

Opening the Control Panel

You can open the Control Panel in various ways:

► From within TRAKTOR: Go to Preferences > Audio Setup and click the Settings button,
located at the right of the Latency slider and display:

► From your desktop: Go to Start > Programs > Native Instruments > Traktor Kontrol Z2 >
Traktor Kontrol Z2 Control Panel.

If you cannot find the Control Panel, the driver is most likely not installed at all. In this case,
please re-install the driver as described in the separate Setup Guide. Here is what you get
when opening the Control Panel:
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The Control Panel.

On the left side, you find two tabs: Audio Settings and Diagnostics.

► Click on the tabs at the left to open the corresponding page of the Control Panel.

Audio Settings Page

The Audio Settings page allows you to adjust the settings of the audio interface.
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The Control Panel with Audio Settings page opened

▪ Sample Rate: The Sample Rate is fixed to 48000 Hz for the TRAKTOR KONTROL Z2's
audio interface.

The sample rate defines how many samples are played/recorded per one second of sound.
A higher sample rate results in higher audio quality; however, 44100 Hz (as used for re-
cording audio CDs) is a common setting and absolutely sufficient for most tasks. If your fi-
nal destination is CD you should use this setting or a multiple of it (88200 Hz). For a bet-
ter understanding: 48000 Hz is used by DAT recorders, and for DVD (films) recording.
96000 Hz is typical for DVD, HD DVD, and Blue-ray Disc audio recording. You should be
aware that a higher sample rate also causes higher CPU load.

▪ Process Buffer: Lower the buffer size value for a quicker response of your computer to
TRAKTOR controller and software actions.
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When converting audio information to digital and vice versa, the audio driver needs to store
the data in buffer packages (audio buffers) which are then sent to and processed by the
CPU. The higher the buffer size, the longer it takes for a signal to finally arrive at the out-
put as audio. You might experience this as late response in between hitting a key on a con-
troller which controls music software on your computer, and hearing sound at the output.
This delay is called latency. A rule of thumb is: lower buffer size results in lower latency.
However, there are more factors to latency than buffer size alone (e.g., CPU speed and
RAM size). You should start off with a higher buffer size setting, and gradually decrease the
value until you find the perfect balance between playability and audio quality for your sys-
tem. If you experience crackling at the audio output, the buffer size is very likely to be too
low for your computer’s CPU to cope with, as lower buffer size causes higher CPU load.

▪ USB Buffer: Use this menu in case you cannot achieve satisfactory Latency settings with
the Process Buffer menu. Lower the USB buffer size for smaller USB buffer packaging,
which should further reduce the audible latency. If you notice any audio interruptions, you
should raise the buffer size until you have a clear sound, free of dropouts.

▪ Processing State : The processing state monitor provides feedback on the current status
of the device. There are three possible status messages:

◦ Idle: controller is connected, but no audio data is being streamed.

◦ Streaming: driver is working and processing audio data.

◦ Panic: driver stopped streaming. Too many USB I/O errors occurred in the interface
communication.

▪ Output Latency : displays your system’s output latency in milliseconds.

Notice there is also an input latency when working with the TRAKTOR KONTROL Z2. The out-
put latency value does not represent the overall latency, from pressing a button on the control-
ler to hearing the resulting effect at the output. The overall latency is about twice as long as
the output latency.

Diagnostics Page

The Diagnostics page allows for monitoring the Z2's performance and for detecting errors.
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The Control Panel with Diagnostics page opened

The information provided in the Diagnostics page might be more of interest to advanced users;
however, in case of problems, you should always have a look at this page.

▪ USB I/O Errors: counts USB input/output errors. A high USB I/O Errors count points to
your system being overloaded.

▪ Buffer Underruns: Buffer underruns occur when your computer isn’t able to process an
audio buffer in time. Reasons for underruns can be too many ongoing background tasks or
high CPU usage within a music program that uses the device as audio driver.

▪ Reset: A click on this button resets the error count.
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▪ Number of Clients: displays the number of clients connected to the interface. Multiple
ASIO applications are counted separately, WDM and WASAPI increase the number by
one, no matter how many WDM/WASAPI applications play audio.

▪ USB Data Errors: counts USB data errors. Poor quality or long cables as well as irradiation
can be the source of data errors on the USB bus.

▪ Reset: A click on this button resets the error count.

▪ Driver Version: See the currently installed driver version here.

▪ Firmware Version: See the currently installed firmware version here.

▪ Troubleshooting Guide: Click Show to open the Troubleshooting Guide.

6.3 Cue/Sample LED Color Illumination
 

The illumination of the Cue/Sample Trigger buttons depends on the underlying Deck Flavor:

For Track Decks

The Cue/Sample Trigger buttons light up according to the following scheme for Track Decks:

▪ Light Blue: HotCue

▪ Green: Loop

▪ Orange: Fade-In and Fade-Out Markers

▪ White: Grid Marker

For Remix Decks

For Remix Decks, the LEDs light up according to the color and playback state of the associated
active cell in the Remix Deck.
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6.4 Cue/Sample Trigger Buttons: Optional Secondary Functions for
Track Decks

 

By pressing SHIFT and a Deck Focus button (see also ↑5.4.5, Cue/Sample Trigger Section (1,
2, 3, 4)), you enter the secondary mode for the Cue/Sample Trigger buttons. The Deck Focus
button then blinks to indicate that it is in secondary mode.

For a general description of the Cue/Sample Trigger buttons, also refer to ↑5.4.5, Cue/Sample
Trigger Section (1, 2, 3, 4).

You can determine what the secondary function will be in the TRAKTOR preferences (in the
TRAKTOR KONTROL Z2 tab, under Secondary Cue).
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The Z2's preferences in TRAKTOR.

The following options are available for Track Decks:

HotCues 5-8

This is the default setting. The buttons will be illuminated according to the type of Cue as-
signed to the button (just like in the primary mode).
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Button Color Function

Blue HotCue

Green Loop

Yellow Load

Orange Fade in/out

White Grid

Off No marker assigned

Brightly lit Active HotCue

BeatJumps

Button Function

Button 1 Forward one beat

Button 2 Back one beat

Button 3 Forward by Auto-Loop size

Button 4 Back by Auto-Loop size

All buttons are lit up orange in this mode; when you hold the button, it will light up more
brightly.

Direct Loops Large

Button Function

Button 1 1 beat loop

Button 2 2 beat loop

Button 3 8 beat loop

Button 4 16 beat loop

All buttons will be illuminated green in this mode where the active button is shown in bright
green.
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Direct Loops Micro

Button Function

Button 1 1/2 beat loop

Button 2 1/4 beat loop

Button 3 1/8 beat loop

Button 4 1/16 beat loop

All buttons light up green in this mode; active button is bright green.

Manual Loops

Button Function

Button 1 Loop in

Button 2 Loop out

Button 3 Loop active

Button 4 4 beat direct loop

All buttons light up green in this mode; the active button is bright green.

6.5 Cue/Sample Trigger Buttons: Optional Secondary Functions for
Remix Decks

 

By pressing SHIFT and a Deck Focus button (see also ↑5.4.5, Cue/Sample Trigger Section (1,
2, 3, 4)), you enter the secondary mode for the Cue/Sample Trigger buttons. The Deck Focus
button then blinks to indicate that it is in secondary mode.

For a general description of the Cue/Sample Trigger buttons, also refer to ↑5.4.5, Cue/Sample
Trigger Section (1, 2, 3, 4).

You can determine what the secondary function will be in the TRAKTOR preferences (in the
TRAKTOR KONTROL Z2 tab, under Secondary Cue).
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The Z2's preferences in TRAKTOR.

The following options are available for Remix Decks:

Sample Retrigger

This is the default setting. All buttons light up according to the associated sample colors. The
buttons are bright when the sample is playing, dim when the sample is stopped or muted, and
dark when no sample is loaded.
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Loop Recorder Controls

Button Function

Button 1 Size (LED is blue)

Button 2 Undo (LED is blue)

Button 3 Record (LED is red)

Button 4 Play (LED is green)

The LEDs are brightly lit when the buttons are active.

6.6 Virtual USB I/O Routing
 

A word on the routing of the virtual USB channels in the software.

USB Outputs

▪ USB OUT 1/2: This signal is fed directly to the Main bus of the Z2 mixer. This signal goes
straight to the XLR/TRS/RCA outputs (via their VOLUME knobs) and to the headphones
when the CUE MIX knob is set clockwise. The crossfader and individual volume faders
have no affect on this output.

▪ USB OUT 3/4: This signal is fed directly to the headphones and requires that the CUE MIX
knob is counter-clockwise in order to hear.

USB Inputs

▪ USB IN 1/2: This is the mic/aux signal.

▪ USB IN 3/4: This is the Channel A Phono or Line Input (depending on the position of the
PH/LN switch).

▪ USB IN 5/6: This is the Channel B Phono or Line Input (depending on the position of the
PH/LN switch).

▪ USB IN 7/8: This is the output of the entire mixer routed back to the computer for the pur-
pose of recording.
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